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Introduction 
EndNote helps you collect and store all the references you have found from different sources. You can use 

your EndNote library to insert in-text citations and create bibliographies within Microsoft Word documents, 

reformatting them into your chosen referencing style. 

If this is your first time using EndNote, we recommend you go through this whole guide in order. 

This guide assumes that you are using EndNote with Word 2010 and Internet Explorer, though you can use 

any other browser. 

 

By the end of this guide you should be able to: 

 Create an EndNote library 

 Add references to your library 

 Use your EndNote library to insert in-text citations and create a bibliography in Microsoft Word 2010 

 Effectively organise your Endnote library 

 

Top tips to keep in mind when using EndNote 

 
1. Use one EndNote library for your course, whole PhD or projects you are working on, and use the 

groups feature in EndNote to organise your references (part 3, section 1). We would only 

recommend you create multiple EndNote libraries if you are working on a number of different 

research projects.   

 

2. Always save a back-up copy of your EndNote library by selecting File > Save a copy.  

  

3. Check for duplicates on a regular basis. Having duplicate references in your EndNote library can 

cause a number of problems, especially when you start to reference your work. (part 3, section 2) 

 

4. Even when using EndNote, it is important to check that the references are appearing properly in your 

work by comparing them with the official referencing guidelines for your style: 

http://library.leeds.ac.uk/skills-referencing. If a reference is not appearing correctly in Word, there 

may be errors in the actual reference in the EndNote library. You will need to edit the reference 

details (part 2, section 3). 

  

http://library.leeds.ac.uk/skills-referencing
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Part 1: Creating and adding references to an EndNote library 
 

1. Opening EndNote and creating an EndNote library 

These instructions describe using EndNote version X7 on a computer in an ISS cluster. 

1. Click Start (or the Windows icon at the bottom-left of the screen) and select All Programs, 
Miscellaneous, EndNote, EndNote X7 
 

2. If an EndNote Web window opens, click Cancel 
 

3. Once EndNote is open, click File and then New 
 

4. Give the file a name and save it to your M: drive (My Documents). 
 

2. Exporting references to your EndNote library 

EndNote can receive references directly from a range of search tools, including many databases; this is 

known as “exporting” references. 

Once you have run your search, most databases have a direct export feature that automatically transfers 

your search results into your EndNote library. Every database is different, but look for links or buttons within 

the database that say ‘export’, ‘EndNote’, ‘download’ or ‘download citations’. If you are not sure whether the 

database allows you to export to EndNote, consult the “how to” information in its help section. 

To try this out, you can follow the example below using Web of Science, or select another search tool that 

you use regularly. There are additional examples for Ovid databases, Search@Library and Google Scholar 

in the appendices of this guide.  

Your subject page also provides information on databases in your subject area: 

https://library.leeds.ac.uk/subjects   

Exporting references from Web of Science: 

1. Go to the Library homepage at http://library.leeds.ac.uk/ or to the ‘IT and Libraries’ tab in the Portal 

2. Type Web of Science into the Search@Library search box 

3. Find Web of Science in the results list and click on the link  

4. Click on the Web of Science --Thomson Reuters link on the following page, then enter your ISS 

username and password when prompted 

5. You are now at the Web of Science homepage. Select Web of Science Core Collection from the 

All Databases drop-down menu next to Search on the top left of the screen.  

 

6. In the first search box, type your keywords and click Search  

7. On the results screen, select the records you want by clicking in the box to the left of each reference 

8. Above and below the results, you have the option to ‘Save to EndNote online’. Click on the arrow to 
reveal the drop-down menu, and choose Save to EndNote desktop  

9. A pop-up box will appear. From the options, choose how much of the record you want to export; we 
recommend you include the abstract. Select Send 

Your records are automatically imported into the EndNote library that you have opened. If you do not have 

an EndNote library open, you will be prompted to choose one. 

https://library.leeds.ac.uk/subjects
http://library.leeds.ac.uk/
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If you are ever prompted for an import filter, scroll down the list that you are presented with and select the 

database you are using, e.g. Web of Science. 

NB: When you export a reference from a search tool into your library, EndNote will automatically try to find 

the full text of the item online. If it is successful, a PDF of the item will be attached to the reference entry in 

your library. 

 

3. Manually adding references to your EndNote library 

Not all databases and search tools have the facility to transfer automatically your search results into 

EndNote. You will need to enter them, and any references you already have, manually. 

Guidelines for entering new references: 

1. Go to your EndNote library 

2. Click References and then New Reference, or select the new reference icon  
 

3. Select the appropriate Reference Type before entering any details. This will mean that the correct 
field titles (Author, Journal, Volume, etc.) are available and so ensure that your reference will format 
correctly  
 

4. You only need to enter information into fields that are essential parts of the reference for your 
reference list or bibliography 
 

5. Authors can be entered in the format Bloggs, Jo C. or Jo C. Bloggs 
 

6. Organisation names must be followed by a comma – e.g. Department of Health, - otherwise EndNote 
will assume the last word is an author's surname and your citations will appear as (Health, 2005) 
instead of (Department of Health, 2005) 
 

7. Where there is more than one author, enter them on separate lines (use the return key after each 
author name) 
 

8. Red text indicates a name that has not been entered into this EndNote library before 
 

9. Move between fields with the tab key or by clicking on each field with your cursor. 

Further guidance on selecting reference types in Endnote: 

http://library.leeds.ac.uk/info/351/endnote_support/254/working_with_endnote/1  

 

4. Attaching full text articles and other documents to your references 

 

1. In your EndNote library, highlight the reference you want to attach the file to 

 

2. Right click it, then choose file attachments 

 

3. Select attach file, then find the PDF file that you want to attach and click Open. 

 

 

http://library.leeds.ac.uk/info/351/endnote_support/254/working_with_endnote/1
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To the right (or sometimes at the bottom) of the screen, you can select 

the PDF tab to view any attached PDF documents. 

EndNote will also display an icon of the PDF document within the full 

reference. Check the document opens by double-clicking the icon. 

You aren't restricted to attaching PDF files - you can also attach Word 

files, Excel files, etc. 

 

 

Important: By default, EndNote will make a copy of the file and place it in a folder associated with your 

EndNote library. If you just want to link to the original, make sure you un-tick the box marked "Copy this file 

to the default file attachment folder and create a relative link".  

Please note that: 

 Un-ticking the box means that EndNote will need to be able to locate the PDF on your PC / laptop 

when you want to access it, e.g. if you have saved the PDF in your M:drive / My documents folder, 

you will need to be using an ISS computer or Desktop Anywhere to access it  

 Leaving the box ticked means a copy of the PDF will be added into your EndNote library (every 

EndNote library creates an attached data folder and the PDF is copied into this folder). This uses up 

computer memory 

 

5. Importing full text PDFs into your EndNote library 

You can import a PDF file or a folder of PDFs directly to your library. EndNote automatically creates the 
reference for you when you import the PDF(s).  

1. In your Endnote library, go to File then scroll down to Import, selecting File 
 

2. Select Choose, then find the PDF file you want to import  
 

3. From the Import Option drop-down menu select PDF, then select Import 
 

4. To import a batch of PDFs, go to File then Import, and select Folder instead of File 
 

5. If you have sub-folders containing PDF files, ensure you select include files in subfolders before 
clicking Import. 

6. EndNote will extract the basic bibliographic data from most PDFs, in order to automatically create a 
reference for you when you import the file 
 

7. If you import a PDF and the details of the reference are not imported, you will need to manually edit 
the reference yourself.   
 

6. Working with PDFs in EndNote 

1. Select the Open PDF icon to view the document in full screen  
2. From here you can search the whole document, highlight and underline text, and annotate with sticky 

notes 
3. You can save all your annotations 
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Part 2: Inserting in-text citations and creating a bibliography with EndNote 

 
EndNote has a feature called Cite While You Write, which starts creating your bibliography as soon as you 

insert your first citation into a Word document. Word 2010 has an EndNote tab that allows you to work 

between your Word document and the references in your EndNote library. 

1. Choosing the appropriate referencing style 

Before you insert any citations into your document, choose the referencing style that you want to use. If you 

later decide you need to reference in a different style, just follow these same instructions to reformat your in-

text citations and bibliography in another style.  

1. In Word, click the EndNote X7 tab at the top of the screen to see the EndNote options 
 

2. In the Bibliography section at the top of your screen, click the drop-
down menu next to Style: 
 

3. Click on Select Another Style to see all available styles 
 

4. Sort the styles alphabetically by clicking on Name, then scroll down to the style you want, e.g. 
LeedsUniHarvard 
 

5. Confirm OK and now all citations and references will be formatted in that style. 
 

6. To choose another style, repeat instructions 1-5 and the citations and bibliography will be 
reformatted. This may take a few seconds. 

 
There are two output styles to match the Library referencing guidance for Harvard and Numeric (you will find 
them under LeedsUniHarvard and LeedsUniNumeric). If they don’t appear in your list, you can download 
them here: http://library.leeds.ac.uk/skills-endnote  
 
 

2. Inserting in-text citations 

 

1. Open a new document in Word and enter some text. Leave the cursor flashing where you would like 
the citation to appear 

 
2. Click the EndNote X7 tab at the top of the screen to see the EndNote options in Word 

 
3. Click Go to EndNote to switch to the EndNote library you have open. Highlight a reference of your 

choice 
 

4. Click on Insert Citation from the options at the top of your screen (the red 
downward arrow).   

 

3. Creating a bibliography 

 
Word and EndNote automatically format the references you add, inserting a bibliography at the end of your 
document.  
 
If new citations added to your text are not automatically appearing in your 
bibliography, click on the Instant formatting drop-down menu and select  
Turn instant formatting on. 
 
If you want to change the way your references are set out, e.g. adding 

http://library.leeds.ac.uk/skills-endnote
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spaces between each reference, removing the indent from the second line of each reference, select the 

Configure bibliography button  underneath the instant formatting options, then select the Layout tab 
from the pop-up box that appears. 
 
If the references in your bibliography do not look correct, it may be that the information is wrong in your 
EndNote library. To fix this: 
 

1. Go into your EndNote library and double click on the relevant reference 

2. Manually edit the reference in your EndNote library  

3. Go back to your Word document, select the EndNote X7 tab and, from the Bibliography box, select 
Update Citations and Bibliography 

 

4. Editing citations  

In some instances, you may need to include page numbers in your citation (for example if you have used a 

direct quote), or you might want to exclude the author (for example if the author's name appears naturally in 

the text - "Smith (2005, p.21) asserts...") 

Adding page numbers to your citation: 

1. Highlight the citation 

 

2. In the EndNote X7 tab in Word, choose Edit and Manage Citation(s) from the Citations box 

 

3. In the Suffix section, enter the page number, e.g. p.23. (You may need to precede p. with a space 

and a comma so there is a gap and comma between the year and page numbers) 

 

4. Click OK. 

In earlier versions of Word, you can use the Edit citation button on the EndNote toolbar to achieve the 

same result. 

Excluding the author from your citation: 

1. Highlight the citation 

 

2. In the EndNote X7 tab in Word, choose Edit and Manage citation(s) from the Citations box 

 

3. Next to the word Formatting, open the drop-down menu and select Exclude author (you can also 

choose to exclude the year or have the citation appear as a reference in your bibliography only) 

 

4. Click OK. 
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Part 3: Managing your EndNote library 
 

1. Using groups 

EndNote X7 allows you to add references to groups. If you are using one library to work on several projects, 

or on several modules, this can be a very useful tool. References can belong to more than one group. 

1. In the EndNote X7 toolbar, click on Groups, then Create Group  

 

2. Under My Groups in the left-hand column, you will see an entry called New Group. You can rename 

any group by right clicking on the group name and selecting Rename group from the menu. 

 

3. To add references to your new group, select the references you wish to add by highlighting them 

(hold down the Ctrl key as you click to select multiple references). Right click on the reference(s), 

scroll down to Add references to and select the appropriate group from the list. If you wish to add all 

references visible in the window, go to Edit in the toolbar, then Select All. Click on Groups in the 

toolbar, then Add references to. Click on the name of the group to which you wish to add the 

selected references. 

 

4. You can also drag and drop references into groups by highlighting them and dragging them with the 

cursor across the screen into a group. 

 

5. To remove references from a group, open the group by clicking on it. Highlight the references you 

wish to remove and, from the Groups option on the toolbar, click on Remove References from 

Group. The references you remove from the group will remain in the All References part of your 

EndNote library. 

2. Checking for duplicates 

If you import from more than one set of results, you may end up with some duplicate references in your 

library. EndNote can help to remove them. 

1. To identify duplicate items, click on References from the toolbar, then Find Duplicates. The Find 

Duplicates box opens  

 

2. At the top of the box there is a message telling you how many duplicates have been found. The box 

displays the duplicate items side by side, inviting you to select which one to keep. To select the item 

to keep, click Keep This Record. 

EndNote identifies duplicate references in a library as references of the same type with matching Author, 

Year and Title fields. It is possible that one of the duplicates will contain more detail than another, so you 

may have a preference as to which reference to keep. 

You should also always manually check for duplicates: If there is even a slight difference in the Author, 

Year or Title fields, EndNote may not recognise that a reference appears twice in your EndNote library.  

To manually check for duplicates: 

1. In your EndNote library, sort the references by clicking on the Author or Title column headings  

 

2. This should help you to spot any remaining duplicates 

 

3. To delete a reference, right click on it and select Move References to Trash. 
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3.  Syncing with EndNote Online 

If you want to use your EndNote library when you are away from a University computer, you can create an 

EndNote Online account. 

You might choose to use EndNote Online as the only way of managing your references (on and off 

campus), but please note that it has fewer features than the EndNote X7 desktop version introduced in this 

guide.  

Our EndNote Online Guide (PDF) will help you to set up an account and to learn how to use EndNote 

Online.  

If you have an EndNote X7 desktop library, it is important to ensure that the references in your desktop 

library are synchronised with your online library, so that the same information is available in both. Please 

note that you can only sync one EndNote Online library with one desktop library, and that syncing can only 

take place from desktop to online. Syncing will make the references in both libraries identical.  

To ensure that your desktop library syncs with the correct EndNote Online account, you will need to connect 

the two by setting your preferences in the desktop version:  

 Go to Edit, then Preferences  

 Choose Sync from the left-hand menu, and fill in the EndNote Account Credentials  

 At the bottom of the EndNote Preferences Sync window, you will also find an option to tell EndNote 

to sync the libraries automatically, i.e. each time a reference is added to the desktop version. 

 You can choose to sync the libraries at any time by going to the Tools menu in the EndNote X7 

desktop version, then selecting Sync 

 

Further help 
 

 For further help, please see our EndNote support pages: http://library.leeds.ac.uk/skills-endnote. 

Here you will find comprehensive guidance on all aspects of using EndNote.  

  

http://library.leeds.ac.uk/downloads/file/542/endnote_web_quick_start
http://library.leeds.ac.uk/skills-endnote
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Appendices 

1. Exporting from Ovid databases 

 

These instructions are for Medline but the same principles apply to all other Ovid databases, including 

PsycINFO and Embase. 

1. Go to the Library homepage at http://library.leeds.ac.uk/ or to the ‘IT and Libraries’ tab in the Portal  

2. Type Medline into the Search@Library search box  

3. Find Medline in the results list and click on the link  

 

4. Click on the Medline -- Ovid Databases link on the following page, then enter your ISS username 

and password when prompted 

 

5. In the alphabetical list, find and click on the link to the most recent section of the database: Ovid 

MEDLINE(R) 1996 to [current year] 

 

6. You should now be on Medline’s advanced search screen 

7. In the search box, type your word or phrase and click Search 

8. Choose which results you want to keep – you can tick individual results or tick the box to the top left 
of your list of results to select all of them (next to where it says Select Range) 

9. Click on the Export option on the bar above your main list of results. This should open a window. 
Click on the drop-down menu called Export to and choose EndNote 

10. Under Select Fields to Display, choose how much of each reference you want to keep. For this 
exercise, the second option Citation + Abstract will be sufficient. This will export details of the 
author, title and source of your results, as well as the summary paragraph 

11. Then click Export Citation(s). If a security box pops up, just click Allow 

12. You may need to select EndNote (rather than Reference Manager, etc.) in another box if you are 
given a choice of destination software. Click EndNote and OK. 

Your records are automatically imported into the EndNote library that you have opened. If you do not have 

an EndNote library open, you will be prompted to choose one. 

If you are ever prompted for an import filter, you need to scroll down the list you are presented with and 

select the database you are using, e.g. Medline (Ovid). 

 

2. Exporting from Search@Library 

 

1. Go to the Library homepage at http://library.leeds.ac.uk/ or to the ‘IT and Libraries’ tab in the Portal  

2. Carry out your search using the Search@Library option 

3. From your search results, mark the items you wish to keep by clicking on the icon next to each item  

 

http://library.leeds.ac.uk/
http://library.leeds.ac.uk/


 

11 
 

This will add them to your saved items folder, which can be accessed at the top of the 

Search@Library screen   

 

 

4. In the saved items folder, select the EndNote option from the Export As… drop-down menu. Click 

on Open 

5. Your items will now be automatically imported into the EndNote library that you have opened. If you 

do not have an EndNote library open, you will be prompted to choose one. 

 

3. Exporting from Google Scholar 

 

Note that you can only export references one at a time, so this option is not suitable for supporting 

comprehensive literature searching. 

You will need to update your preferences inside Google Scholar before you can send any references to 

EndNote. Follow these steps to configure Google Scholar to send references to EndNote. 

 

1. Go to the Google Scholar homepage at http://scholar.google.co.uk 

2. Click on the "Settings" link 

3. Under "Bibliography Manager", select the option "Show links to import citations into" and choose 
"EndNote" from the menu 

4. Click on the "Save" button 

 

Follow these steps to import search results into EndNote. 

1. After performing a search on Google Scholar, click on the "Import into EndNote" link under the 

reference you want to import. 

2. If you are presented with a window asking if you want to "Open" or "Save" the file, choose to open 

the file 

3. A security box will appear. Click ‘Allow’ to allow the reference to be imported. 

 

http://scholar.google.co.uk/

